
 
 

This was written for Microsoft PowerPoint 2000 for Windows. Newer or older versions may 
have different options and ways to do things. Also this is not meant to cover all of PowerPoint 
just the general features of it. There may be some items left out. Complied by Sean Pearson 
(sean@iollan.com) Copyright 2004. All rights reserved. Copies may be made for educational 
use only.  
 
1. Open PowerPoint. 
2. Click on Design Template and hit OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Select the template you want from the ones pictured. You can preview each by clicking on it 

and looking at the preview at the right. Hit OK when you find the one you desire. 

 



4. The “New Slide” 
box will come up. 
There are 24 
different slide views. 
The chart below will 
explain each choice. 
The position in the 
table corresponds to 
the position in the 
“New Slide” box.  If 
you click on the 
choice the box on the 
right tells you what 
the slide is. An 
object is anything: 
clip art, chart, or 
movie. 

 
 

Title Slide: 
You have two boxes 
to put a title and a 
subtitle. 

Bulleted List: 
There is a title box at 
the top. Then you are 
able to do one 
bulleted list. 

2 Column Text: 
There is a title box at 
the top. Then you 
have the ability of 
having two side-by-
side bulleted lists. 

Table: 
There is a title box at 
the top. You can also 
add a table with the 
rows and columns that 
you choose. 

Text and Chart: 
There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have a chart. Double 
click to open 
Microsoft Graph. 

Chart and Text: 
There is a title box at 
the top. On the right 
side you can have a 
bulleted list. On the 
left side you can have 
a chart. Double click 
to open Microsoft 
Graph. 

Organizational Chart: 
There is a title box at 
the top. You can input 
an organizational 
chart in the box below 
that if you have the 
software to do so. 

Chart: 
There is a title box at 
the top. You can input 
a chart in the box. 
Double click to open 
Microsoft Graph. 

Text and Chart: 
There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have a clipart. Double 
click to insert a clip 
art. 

Chart and Text: 
There is a title box at 
the top. On the right 
side you can have a 
bulleted list. On the 
left side you can have 
a clipart. Double click 
to insert a clip art. 

Title Only: 
There is a title box at 
the top. This slide is 
not formatted for 
anything else. 

Blank:  
This slide is not 
preformatted in any 
way. 

Text and Object: Object and Text: Large Object: Object: 



There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have any object. 
Double click and 
select from listing. 

There is a title box at 
the top. On the right 
side you can have a 
bulleted list. On the 
left side you can have 
any object. Double 
click and select from 
listing. 

There is a place to 
enter a large object. 

There is a title box at 
the top. There is a 
place to put an object 
below it. 

Text and Media Clip: 
There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have a media clip. 
Double click to insert 
a media clip. 

Media Clip and Text: 
There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have a media clip. 
Double click to insert 
a media clip. 

Object Over Text: 
There is a title box at 
the top. On the bottom 
you can have a 
bulleted list. In the 
middle you can have 
any object. Double 
click and select from 
listing. 

Text Over Object: 
There is a title box at 
the top. In the middle 
you can have a 
bulleted list. On the 
bottom you can have 
any object. Double 
click and select from 
listing. 

Text and 2 Objects: 
There is a title box at 
the top. On the left 
side you can have a 
bulleted list. On the 
right side you can 
have any 2 objects. 
Double click and 
select from listing. 

2 Objects and Text: 
There is a title box at 
the top. On the right 
side you can have a 
bulleted list. On the 
left side you can have 
any 2 objects. Double 
click and select from 
listing. 

2 Objects Over Text: 
There is a title box at 
the top. On the bottom 
you can have a 
bulleted list. In the 
middle you can have 
any 2 objects. Double 
click and select from 
listing. 

4 Objects: 
There is a title box at 
the top. Underneath 
you can put four 
objects. 

 
Pick the one you want and hit ok. Your first one should be the title slide. 
 
5. Click where it says to and 
then type your title and sub-
title. 
 
 
 
 
 
 
 
 
 
 
 
From here you can do many things. I will try and explain each one. 



 
To make a new slide:  
1. Go to the Insert Menu and select a New Slide. 
2. Chose the slide you want and hit ok. Refer to the chart above. 
 
 
 
 
 
 
To change the view:  
1. Go to the view menu. 
2. You have four options. 
3. Normal: This allows you to view the presentation one slide at 

a time. This is the default view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Outline: This allows you to view all the text in the presentation. You can view each slide by 

clicking on the card icon next to the number. (Not listed on menu) 
 

 



5. Slide Sorter: This allows you to view thumbnail pictures of the slides in your presentation all 
at once. 
 

 
 
 
6. Notes Page: Allows you to view each individual 
slide. Underneath the slide is a box where the 
presenter can type in any notes they may wish to. This 
will not be displayed during the presentation.  
 
 
 

 
 
 

You can also change the slide view with the buttons on the lower left side. Starting from the left 
to right: Normal View, Outline View, Note View, and Slide Sorter View. The last button will 
start the presentation on the slide that is currently selected.  
 
To delete a slide: 
1. Go to the view menu and select slide sorter. 
2. Click on the slide you want to delete. 
3. Hit the delete key 
4. Click on normal view button to continue. 

 
 
 
 



To print: 
Unless you want to print one slide per page there are various ways to print your presentation. 
 
 
1. Go to File menu and click print. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Type in the number of 
copies you want in the box to 
the right.  
 
3. You have four printing 
options under the Print what 
field. Select the one that you 
want. See below for 
explanations 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Slides: This is the default choice. This allows you to print one side at a 
time. 

Handouts  

You can print 2, 3, 4, 6, or 9 slides on one sheet. You pick the 
number in the Slides per page field once you select handouts on 
in the Print what field. You can also select what direction the 
order is in. NOTE: If you want to print a slide on the left and 
then lines on the right for people to take notes pick 3. 

Notes Pages 
This prints the slide on the top half of the page and the 
presenter’s notes on the bottom. This way a presenter can have 
the notes that correspond to the slide that they are on.  

Outline view  This allows you to print just the outline of the slides without the 
colors or graphics. 

 
4. For good measure, if possible, click frame slides and scale to fit paper. You may also select 
grayscale or black and white.  
5. Hit print. 
 
To change the layout of the slides: 
1. Go under the view menu and highlight the 

master option. 
 

2. There are four options. When you make changes 
on the Masters they will appear on every slide. That 
way if you want the same font on each slide or your 
name in the footer, change it here and then you 
never have to change it again. See below for what 
you can do. (I am only showing the Slide Master. 
However, you can change the same things on the 
Title Master.) 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the default title here. Change to the font that you want or 
if you want the same title on each of the slides put it he re. 

You might want to put 
your name or company in 
the footer. 

Delete the date/time box and the number area box if 
you do not want those to appear on the slides. 

You can change the font size, style, and 
color for all the slides here. You can also 
change the bullets for each level. (More 
on changing bullets later.) 

You can also click and hold on each of boxes to 
change the position of each box. Drag it where 
you want it to go and let go of the mouse to place 
it there. 



The Insert Menu: 
From top to bottom: 
 
New Slide: This allows you to enter a new slide after the slide you are 
currently on. If you slide you are on is not the end slide then this will 
allow you to insert a slide in between the current one and the next. 
 
Duplicate Slide: This will insert a copy of the slide you are on 
following the same rules as New Slide. 
 
Slide Number and Date and Time: If you choose this you will get a 
message. Hit OK. It should bring up the following: 
 

 
 
 
 
 
 
 
 
Select what you want to 
appear on each slide and type 
it in if you so desire. Hit 
Apply if you just want it on 
the current slide. Otherwise 
hit apply to all. 
 
Picture and Object: See 
below. 
 
 
 

 
Textbox: This allows you to create a box that you can type text in. Once you select textbox click 
the mouse where you want the box to be and then drag to get the correct size. 
 
 
 
 
 
 
 



Hyperlink: If you want the text that you just typed to link to a webpage, highlight it and select 
Insert -> Hyperlink. Type the file path or webpage address where it says. Or you may choose to 
browse for the file. On the left you can also choose to link to a slide in the presentation that this 
link will go to when you click the link. Pick one and hit OK. 
 

 
 
To insert a picture: 
Select Picture under the Insert menu. It will 
bring up the following menu: 
 
Clip Art: If you select this it will open the 
clip art library. Find  the clip art you want. 
Click on it and select the first option in the 
menu pops up. This will place in your 
document. Click on it and drag it where 
you want. 
 
From File: When you click on this it will 
open up the Open File window. Find the 
picture you want and click Open. Place the 
picture as if it was a clip art. 
 
 
 



AutoShapes: The AutoShapes toolbar should be on the bottom of the 
screen.  When you click on it the bottom it brings up the menu on the 
right. Explore the shapes as you desire. 
 
 
 
 
WordArt: This can be used to make titles. The first option it will 
bring up is the following. Pick the one that best appeals to you and hit 
OK. 

 
 
Type in your text and choose the font type and size. Hit OK. 
 

 
 
 
 
 



 
 
It should place your WordArt in the presentation and bring up the toolbar below. 
 
 
 
 
 
 
 
 
 
To insert an object: 
As stated before an 
object is a media. 
When you pick this 
choose what the media 
is from the menu 
pictured. 
 
 
 
 
 
 
 
 

 
The Format menu:  
Font: Allows you to change the font, style, size, effect and color. 
 
Bullet: If you want to change the bullet for the bulleted- list pick this. 
It will bring up a chart full of symbols. Select the one you want and 
hit ok. 
 
Alignment: Lets you choose the alignment of the selected or future 
text. 
 
Line Spacing: Let's you change the spacing in between lines and 
paragraphs. 
 
 Change Case: Lets you change the text 
to look like one of the five choices. 
Standard is Sentence case. 

This allows you to go 
back and edit the text 
for the WordArt. Let's you change the style, format 

WordArt, change the shape and rotate 
the WordArt 

Let's you put it that all 
the letters have the 
same height, changes 
the letter position, 
alignment, and tight the 
letters are. 



 
Replace Fonts: If you wanted to change one font for another this is the way to do it without 
having to select all the text you want to change. WARNING: This will change the text for the 
entire presentation. 
 
Slide Layout: Allows you to change the layout 
of the slide to another one. See the chart at the 
beginning of this to see an explanation of the 
various slides. 
 
 
 
Slide Color Scheme: Each 
template comes with its own 
built in colors. If you want to 
change the color scheme for the 
presentation or for just one slide 
use this option. It will bring up a 
window for preset color 
schemes that go with this 
template. 
 
 
 
 
 
 
 
 
 
Or if you do not like one of 
the preset ones you can hit 
custom and change the 
individual items. Again you 
can apply this to all slides or 
just one. It will show a 
preview so you can see it 
before you apply it. 
 
 
 
 
 
 



Background: This is not used that often. It allows you to change the background color or fill 
pattern. This can be done in the color scheme choice as well. 
 
1. Apply Design Template: Allows you to do the same as in step 3 on page one. The interface is 

different however. If the directory that appears is not template directory it should be located 
in your office directory as Templates and then Presentation designs. 

2. Scroll through them and pick the one you want. 
WARNING: This will change the design for all of the slides. 
 
To check spelling: 
1. Go to the Tools menu. 
2. Check on spelling. 
3. This is the only item that you will probably use for Tools. 
 
The Slide Show menu: View Show: Unlike the button that starts from the current slide this 

option starts the show from the beginning. 
 
Rehearse Timings: This allows you to preset the timing for the slide 
show. You select this, speak as you were giving the presentation and 
click the mouse as you need to change slides. The computer is timing 
how long to display each slide at the 
lower right-hand corner of the screen.  
 
Once you finish the finish the show it will ask you if you want to use the 
timings. Click yes or no. Then it will take you into slide sorter mode. If 
you are not happy with the times do it again. If you are then you can 
now do a presentation without having to click the mouse to advance the 
slides. 
 
Record Narration: If you have a microphone that works you can record 
narration for slides. This is useful if you cannot be there to present. 
 

 
Set Up Show: Brings up the 
menu up at the right. The first 
three choices let you decide how 
it is being presented. The next 
three set limits on the show. 
Most likely you would want to 
use the default. In the slides 
section you can tell it only to 
show certain slides. And you 
can turn the timing off in the 
advance slides option. 



Action buttons: Provide greater functionality to your 
slides. Select the one that you want. You then have to 
click where you want the button to be on the slide. 
Once you do that it will bring up the Action Settings 
menu (picture and explanation next page). Pick the 
settings you want and hit ok. 
 
Custom: Can be anything that you can set the action 
settings to be.  
 
 

 
Home: When clicked on during the presentation this button will allow you 
to go back to the first slide. 

 
Help: You preset what this button does during the  
presentation when you choose it. Most likely you would  
want to hyperlink it to a slide that you have set aside for  
help information. 

 
Information: You preset what this button does during the presentation 
when you choose it. Most likely you would want to hyperlink it to a slide 
that you have set aside for help information. 

 
 

Previous Slide, Next Slide, 
First Slide, and Last Slide: 
When you click on these 
buttons during the 
presentation it will take you 
to where it says. (pictured in 
order) 

Last Slide Viewed: This will take you to the last slide that was viewed 
during the presentation. Put this on information or help slides.  

          
 
 
 

Document, Sound, Movie: This should 
allow you to choose a document that will 
open or a sound or movie that will play 
when the button is clicked on. 
 
 



Action Settings: Action settings can be 
applied to any object. You have two 
options: Mouse Click and Mouse Over. An 
object must be selected before you can use 
Action Settings. 
 
None:  Default for most objects. 
 
Hyperlink to: When the object is clicked on 
during the presentation it will jump to what 
you have selected. (See choices lower left) I 
will explain the ones that are not self-
explanatory.  

 
 
 
End Show: Will automatically end the show. 
Custom Show: Links to a custom show. 
Slide: Allows you to link to a slide that is not the next one. 
URL: Allows you to link to a webpage. 
Other PowerPoint presentation and file: Links to files and presentations that are on your 
computer. 
 
Run macro: I would advise not using macros in your documents. Several viruses are enabled 
through the use of macros and people will not open files that have macros in them. (Not all 
macros are harmful and if you create one if won't be a virus. However, there are some people 
who created macros that are viruses.) 
 
Object action: Each object has its own action relating to it. Click and it  and select this dropdown 
list to check it out. 
 
Play sound: Allows you to play a certain sound if you click on the object during the presentation. 
 
 
 
 



Preset Animation:  
Works in two ways: either with an object or with a slide. To use with an 
object click on that object and then go to the preset animation and pick on 
of the choices (choices vary with object selected). To use with a slide, 
change your view to slide sorter (see above) and click on the slide you 
want to use the animation on. Then select your animation from the menu 
options. (Pictured) 
 
 
 
Custom Animation: 
This allows you to customize animation instead of using a preset one. The 
top half will be explained first and then the four tabs will be explained. 
 
Check to animate slide objects: This allows you to check which objects 
are being animated. The window next to it shows which object is being 
selected. 

 
 
The order and timing tab allows you to say in what order and object is animated. Also you can 
determine if it animates (appears) when you click the mouse or after a certain amount of second 
after the last event or animation. 

 
 
 
 



Effects Tab: If the object is not a text box then the only options that you have is to change how it 
appears in the presentation and if a sound plays. With text you have those options and you can 
change how the text appears on the screen. You have the choice of all at once, by word, or by 
letter. (If you introduce by letter and are playing a sound that can get rather annoying.) 

 
 
Chart and Multimedia settings: Are only used when you have a chart or a movie. 
 
Animation Preview: 
Allows you to preview the animations that you just selected in a mini window. This way you do 
not have to play the slideshow to see the 
animations. 
 
 
 
Slide Transition:  
This allows you to select how slide change 
from one to another. You can change the 
effect, add a sound when you change slides, 
and choose how fast the slides advance. You 
have the option of making it work for just the 
current slide or having it as the default 
transition for the entire slide show.   
 
 
 
 
 
Hide Slide: 
If you choose hide slide, it will hide the current slide that you are. When you play the slide show 
any slides that are hidden will not appear in the show. This way you can use only slides from the 
slide show that you want without having to dele te them or make a custom show. To unhide it just 
select the slide again and choose hide slide. 
 



Custom Show: 
Custom Shows are useful if you only want to show certain slides and you don't want to deal with 
buttons or hiding slides. Select custom show and then hit new. The following should come up. 

 
 
Name the show whatever you like. Click on the slides that you want in the custom show and hit 
add. You can change the order by using the arrow keys to the right. (Note: Slide number one is 
hidden as it has the ( ) around it.) 
 
Once you have added you can copy, remove, edit, or show it. You can have more than one 
custom show per presentation. 

 


